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This application note covers testing of an amplifier’s linear S-parameters and gain
compression using Agilent’s microwave (MW) PNA Series of vector network analyzers.
The MW PNA Series can also be used for testing amplifier nonlinear parameters such as
harmonics and intermodulation distortion. Agilent Application Notes 1408-8 and 1408-9
cover the topics of harmonics and intermodulation distortion testing respectively.

Amplifiers are a fundamental building block of microwave systems, and characterizing the
performance of amplifiers is a critical factor in the design process. Network analyzers are
traditionally used for linear amplifier measurements, while spectrum analyzers are used
for nonlinear measurements such as harmonics and intermodulation distortion. However,
many of the modern network analyzers, including the Agilent MW PNA Series, can be
used for nonlinear measurements as well, by enabling the frequency-offset functionality.




Definitions

In this application note, the device
under test (DUT) is an amplifier with the
following specifications.

Frequency range 0.10 to 1000 MHz
Minimum small
signal gain 20dB
Input SWR 1.5:1
QOutput SWR 2.0:1

Output 1 dB compression +3 dBm

Note

MW PNA [front-panel keys] are shown in
brackets, while the softkeys are displayed in
bold; “menu item” refers to the Windows®
drop down menus.

Gain

Amplifier small signal gain is defined as the ratio of an amplifier's output power delivered
to a Z; load to the input power delivered from a Z; source, where Z; is the characteristic
impedance in which the amplifier is used (50 ohms in this note). In logarithmic terms,
gain is the difference in dB between the output and input power levels at a particular
frequency.

Reverse isolation

Reverse isolation is a measure of transmission from output to input. The measurement of
isolation is similar to the measurement of small signal gain, except that the stimulus is
applied to the amplifier's output.

Deviation from linear phase

Ideally, the phase shift through an amplifier is a linear function of the frequency applied.
The amount of variation from this theoretical phase shift is called deviation from linear
phase or phase linearity.

Group delay

Group delay is a measure of the transit time through an amplifier at a particular frequency.
It is defined as the derivative of the phase response with respect to frequency. Similar to
deviation from linear phase, it is a measure of amplifier distortion.

Return loss/SWR

Return loss is a measure of the quality of the match of the input and output of the amplifier,
relative to the system impedance. Reflection coefficient includes both magnitude and
phase information of the reflected signals. Return loss and SWR are ways of examining
the magnitude portion of the reflection coefficient.

Gain compression

An amplifier has a region of linear gain, where the gain is independent of the power level.
This gain is commonly referred to as small signal gain. As the input power is increased
to a level that causes the amplifier to approach saturation, the gain will decrease,
resulting in a large signal response. In this application note, the 1 dB gain compression
is defined as the input power level where the amplifier gain drops 1 dB relative to the
small signal gain.




Transmission
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Figure 1. Setup for testing transmission and
reflection parameters.

Note

At preset, the source power level of the MW
PNA Series network analyzer is set to —17 dBm,
with the internal source attenuator on port 1
set to 0 dB. If the amplifier under test could be
damaged by this power level, or will be operating
in its nonlinear region, do not connect the
amplifier until you have set a desirable

power level.

Step 1: Setup

The first step of a transmission measurement is to set up the stimulus settings of
frequency range, power level, number of points, and IF bandwidth.

[Preset]
[Start/Center] > Start 0.1 [G/n] > Stop 1 [G/n]
[Power] > Level —20 [Enter]

In addition to damage level, it is advisable to consider the compression level of the
network analyzer. In the 0.1 to 1 GHz frequency range, the MW PNA receivers have 0.6 dB
compression at +5 dBm test port input power.

Given our amplifier's gain of approximately 20 dB and input power level of —20 dBm, the
result will be a signal with roughly 0 dBm of power incident upon the test port. Therefore,
we do not need to enable the receiver attenuators in this example. If necessary, the
receiver attenuators can be enabled via the menu item Channel, Power...

(Power x|
[V Power On
— Port Selection

Port [1_5 ¥ Port Power Coupled

Test Port Power

—&ttenuator Contral

¥ Auto Fos
i Power Slope

I~ Slope [000dB/GHz E

eceiver Attenuation

Receiver & IDdE E
ReceiverB [0dB [£]

Cancel | Help I

Figure 2. MW PNA internal receiver attenuators make amplifier measurements easier by
reducing the need for external attenuators.

[Sweep Setup] > Points > 401 [Enter]

MW PNA Series allows the user to measure up to 16,001 points. If you have an amplifier
with a wide frequency span, measure more points to get better frequency resolution.
Alternatively, calibrate with many points over a wide frequency range. Then zoom in on
a subset of the frequency range and still have excellent resolution and many calibrated
points.

[Sweep setup] > Bandwidth

Verify that the network analyzer’s IF bandwidth is set to the default 35 kHz. This is
probably an adequate bandwidth for amplifier gain measurements, since a gain
measurement does not require the maximum dynamic range, and you want to maximize
measurement speed. If you have a high dynamic range filter connected to the amplifier
as part of the DUT or would like to lower the system noise, reduce the bandwidth.

MW PNA Series offers a range of IF bandwidths, from 1 Hz to 40 kHz.



High gain amplifier considerations

When measuring high gain amplifiers, it is possible to damage the test port couplers,
receivers, receiver attenuators, or source/splitter assembly. For the MW PNA, the damage
levels are: +20 dBm at the test port (limited by the source/splitter assembly), +30 dBm
for the couplers and bias-tees (if the source/splitter assembly is protected through
source attenuation), +15 dBm for the receivers, and +30 dBm for the receiver attenuators.
The MW PNA source attenuators (Option UNL) cover a 60 dB range, in 10 dB steps.

The receiver attenuators (Option 016) cover a 35 dB range, in 5 dB steps.

If the amplifier output is connected to the test port input, do not apply more than

+20 dBm to the test port input, since power levels higher than +20 dBm will damage
the source/splitter assembly. If you have the source attenuator option, you can apply
10 dB or more of source attenuation, and then apply +20 dBm to the coupler input.
You also have to protect the receiver, via the receiver attenuator. Though there is at
least 14 dB of loss between the test port and the receiver, due to the coupler.

If the amplifier output is connected directly to the receiver input, via the front panel
jumpers, then the signal is not incident upon the source/splitter assembly, and is
directly incident upon the receiver or receiver attenuator. In such a case, the damage
level is +15 dBm if the receiver attenuator is not used, and +30 dBm if the receiver
attenuator is switched in. If you use the receiver attenuator, you can put in +30 dBm
into the jumper input, apply 15 dB of attenuation, and make a valid measurement.

Please note that all of the power levels mentioned in Step 1 are damage levels.

We recommend that you reduce the incident power upon the receivers well below
the damage level, and even below the compression level, to obtain the most accurate
measurements.

When measuring high gain amplifiers, it is recommended that you take advantage of the
“Port Power Coupled” feature to uncouple the power of ports 1 and 2. Drive the input, or
port 1, with a low power level as to not damage the output receivers. Drive the output, or
port 2, with a high power level, so the isolation or S;, measurement does not approach
the noise floor of the network analyzer. An accurate S;, measurement is fundamental to
an accurate 2-port calibration.




Step 2: Calibrate

A two-port calibration provides the maximum accuracy for this measurement. Agilent's
electronic calibration (ECal) modules make the task of calibration much easier and less
prone to user errors. You can learn more about ECal by visiting our website at
www.agilent.com/find/ecal.

[Cal] > Cal Wizard

Calibration Wizard: Begin Calibration

" SmartCal (GUIDED Calibration]: Use Mechanical Standards

" UNGUIDED Calibration: Use Mechanical Standards Select calivation preferences.
: Mot sure about pref 7 Assistance i
& {38 Elestionic Cabration [ECal available in the aniine Help,

" Mixer Calibrations

[V Create new Cal Set I~ Save Preferences. Don't show this page again.

¢ Back I Mext > I Cancel I Help

Figure 3. The MW PNA Calibration Wizard simplifies various calibration procedures.

Follow the recommended steps in Calibration Wizard. Save the instrument state with a
pointer to the calibration set as a file “amplifier.cst.”

PNA Series Network Analy:
File View Channel Sweep

Recall...
->1 amplifier.cst
Save Cti+S
Manage Files...
Print... Ctil+P
Print Optiohs...
Piint to File. ..
Exit

Figure 4. With the MW PNA's Windows 2000 operating system, file manipulation is as easy as it
is on your personal computer.

Once the calibration has been completed, verify that it is active. Turn on the network
analyzer Status Bar by selecting it under the menu item View, and verify that the
calibration indicator “C 2-P SOLT" appears on the bottom of the screen.

_l Ch1: Start 100,000 MHz = Stop 1

| Status CH1: [520 ([C 2PS0LT )

Figure 5. The MW PNA status bar provides you with valuable information, including the
calibration type and status.




Step 3: Measure

Next connect the amplifier between port 1 and 2, and perform the measurements.
Be sure to apply any appropriate biasing.

Gain or Sy,
Small signal gain is gain of the amplifier in its linear region of operation. This is typically
measured at a constant input power over a swept frequency range.

[Measure] > Sy

Group delay

Group delay, like deviation from linear phase, is a measure of amplifier phase distortion.
The MW PNA calculates group delay from the phase and frequency information and
displays the results in real time. This measurement may require a specific group delay
aperture. The minimum aperture is equal to the frequency span divided by the number of
points minus one. Increasing the aperture reduces the group delay resolution, but lowers
the trace noise.

Deviation from linear phase

The deviation from linear phase measurement employs the electrical delay capability of
the MW PNA to add electrical delay to the amplifier in order to remove the linear portion
of the phase shift.

To view the gain in different formats, we can easily take advantage of the multi-parameter
display capability of the MW PNA, by using a preconfigured setup. Configure window 2
for phase measurement, window 3 for group delay, and window 4 for deviation from
linear phase.

[Measure Setups] > Setup B

Select window 2. [Measure] > $21 > [Format] > Phase
Select window 3. [Measure] > S21 > [Format] > Delay

Select window 4. [Measure] > $21 > [Format] > Phase
[Marker] > [Marker function] > >Delay

Place the marker in the center of the amplifier frequency span, and then activate the
electrical delay function. By flattening the phase response, we have effectively removed
the linear phase shift through the amplifier under test. The deviation from this linear
phase shift remains.
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Figure 6. View multiple amplifier parameters on one screen, using MW PNA's 4-parameter
display capability.

Reverse isolation or S;,

For an isolation measurement, the stimulus is applied to port 2, or the output of the
amplifier, and the signal level at port 1, or the input, is measured. For amplifiers with
very high isolation, the noise floor of the MW PNA Series can be lowered by reducing
the IF bandwidth.

At this point, you may want to recall the original instrument state to start with a clean
trace, or you can remove the delay that was added in the previous step.

[Recall] > ampl... cst
[Measure] > S12




Reflection Measurements

Note

If the amplifier under test is operating in its
nonlinear region, the large signal Sy, should
be measured using a load-pull technique.
Traditional S-parameter measurements depend
on the amplifier operating in its linear region.

Step 1: Setup

Reflection measurement can be made using the same setup as transmission measurements.

Step 2: Calibrate

Reflection measurement can be made using the same two-port calibration as transmission
measurements.

Step 3: Measure

Input and output return loss — Sy; and S,,

Return loss and standing wave ratio (SWR) are commonly specified for the amplifier’s
input and output ports. With the MW PNA Series, you can view the reflection parameters
in return loss or SWR format.

First set up an Sy trace and then add an Sy, trace to the current display.
menu item Trace > [Measure] > $11 > [Format] > [Format] > SWR

menu item Trace > New

Select second trace [Measure] > S22

“i{l PNA Series Network Analyzer - [Window 1 ] i =181 x|
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Figure 7. Measure the input and output match of an amplifier using the MW PNA.




Gain Compression

PNA network analyzer
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Figure 8. Setup for testing gain compression
and swept-harmonic response measurements
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There are two ways to measure amplifier gain compression: swept frequency gain com-
pression and swept power gain compression.

Swept frequency gain compression

This measurement allows the user to easily determine the frequency at which 1 dB gain
compression first occurs. This is accomplished by normalizing to the small signal gain
and by observing the reduction in gain as input power is increased.

Swept power gain compression

By applying a fixed frequency power sweep to the input of an amplifier, gain compression
is observed as a 1 dB drop in the gain from the small signal value. The fixed frequency
chosen is often the frequency for which 1 dB compression first occurred in the swept fre-
quency gain compression.

Gain compression can be specified in terms of both input power and output power.

Since gain compression is specified at an absolute power level, absolute power accuracy
is desired. With the MW PNA Series, a source power calibration (same as power meter
calibration) provides input power accuracy, while a receiver calibration provides output
power accuracy.

Step 1: Setup

In this procedure, we will take advantage of the multi-channel and multi-trace features of
the MW PNA Series.

Configure the MW PNA as follows:

Channel Sweep type Traces Frequency  Source power Calibration
Swept frequency Ch 1 Frequency sweep 1 trace, Sy, 0.1to1GHz -20dBm 2-port cal
gain compression
Swept power Ch2 Power sweep 2 traces, Sy;and B 0.1 GHz —251t0 0 dBm 2-port cal,
gain compression Src Pwr Cal, Revr Cal
x| Recall the “amplifier.cst” instrument state as a starting point for channel 1.
S-Parameters
[Recall] > ampl... cst
I~ sn v 521
[Measure] > S21
I~ 512 I s22
— Configure channel 2, using the menu item Trace, with two traces: an S, and a
More Types.. Applicaton.. B trace. Be sure to select channel 2, as the network analyzer defaults to channel 1.
|2 > | chlnnel Mumber A “B” receiver measurement allows you to observe the absolute output power of the
; amplifier. Use the menu item Trace, and then More Types... Unselect Ratioed Type.
Cancel | Help |

Figure 9 . Measure gain with an Sy, trace.



[More Trace Types x| Next configure channel 2 for a power sweep, from —25 dBm to 0 dBm.
 Type Definition
Source Patt [Sweep Type] > Power Sweep
[Power] > Start Power > —25 [Enter]
Input Stop Power > 0 [Enter]
A o
B g [Start/Center] > CW Freq > 100 [M/p]
Rl & R
 R2 B2 “il PNA Series Network Analyzer BB
= File Wiew Channel Sweep Calibration Trace Scale Marker System Window Help
1 St Ref Level [ 22.000 dB Bl auoscae Scae | R
| @ChannalNumber — —
3 Window 1
I Create in New Window B2iLog Mag 700 Be-s21
1.000dE/ )
ok | cancal | Hep | Zo00dB  psoo
P4.00
P3.00

Pz .00

Figure 10. Measure absolute output power
with a B trace.
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Figure 11. Configure S, traces as the initial step for swept frequency gain compression
(top trace), and swept power gain compression (lower traces)

Perform a quick check on the measurement before calibrating the test setup. The Sy,
trace of channel 1 should display the approximate gain of the amplifier, while the S,; and
B traces on channel 2 should show a typical gain compression curve.

Step 2: Calibrate

Once the setup in complete, perform a calibration on both channels. On channel 1, you
can use the calibration from the first step — a two-port calibration is adequate.

On channel 2, perform three calibrations: (1) A 2-port calibration on the S, trace, (2) a
source power calibration on the S, trace, and (3) a receiver calibration on the B trace.

Perform the 2-port calibration using the ECal module.

The source power calibration functionality is located under the menu item Calibration.

"



Receiver Power Cal 8

Calibration sweep is complete. Click OK to activate.

Power Selection

Cal Power | -25.0 dBm E

[V Using power level from Source Power Cal

Cancel

Figure 14. A receiver calibration provides
output power accuracy.
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Figure 12. Source power calibration transfers the accuracy of a power meter measurement to the

MW PNA source.

Connect an appropriate power sensor to test port 1 and then perform the calibration.
On the Source Power Cal dialog box, make sure you select channel 2, as channel 1 is
the default.

Source Power Cal i |

r— Channel and Port Selection  Loss Compensation

@oulce Port |1_E

Power Selection

™ UseLoss Table

Edit Table |

Power Meter Settings-

Edi... |
Take Cal Sweep |

ok |

Test Port Power I 17.0dBm

Cal Power | -17.0 dim

¥ Cal Power same as Test Port Power

Cancel I Help I

Figure 13. A source power calibration adjusts the output power of the network analyzer for
absolute power accuracy.

Next, perform a receiver cal. A receiver cal is essentially a trace normalization, similar
to a response cal. The difference between a receiver cal and a response cal is that a
receiver cal is performed on the B receiver and provides absolute accuracy, whereas a
response cal is performed on an S,; measurement and provides relative accuracy. An
accurate receiver cal starts with a source power cal as the reference.

Make a through connection between port 1 and port 2 and perform the calibration.




Step 3: Measure

Once both calibrations are complete, connect the amplifier and observe the display.

Note the status bar on Figures 15 and 16. On Figure 15, S,; is selected and the status bar
shows a “2-P SOLT” and “Sre Pwr Cal”. On Figure 16, B is selected and the status bar
shows a “Revr Cal” and “Src Pwr Cal”.

B2|Log Mag'\ E&00 I- EF|Log Mag | 1200 -
2 O00dEY 00 2 000dE 10.00
16.000dE b2 00 16.000dE 4,00
Blog Mag £0.00 £.00
2 000dEY 12.00 et 400 -
5'000dB 16.00 el 2.00 L
14.00 — 0.00 j.,--"-""'/
12.00 2 .00
10.00 400
2.00 LE 0D
6.00 H2 .00
Cha: Start -23.000 dBm = =——— Ch2: Start -25.000 dBm

Status CH 2 [521 C

C 2P SOLT  SrcPwCal

Status CHZ B (C RowiPwr  SrcPw Cal

Figure 15. A 2-port cal is applied to the S,q trace.

Figure 16. A Rcvr Cal is applied to the B trace.
Now that the calibrations are complete, start the gain compression measurement.
Channel 1: Swept frequency gain compression
Select the Sy, trace of channel 1. Normalize the trace by using the data to memory
functionality of the MW PNA.
[Math/Memory] > Data >> Memory > Data/Mem

The modified S,; data trace should show 0 dB gain. Next, using the rotary knob, increase
the source power level until the trace drops by 1 dB at some frequency point.

[Power] > Level > Increase power using the knob

A marker can then be used to track the exact frequency where 1 dB compression first
occurs. Observe the power level on the display. This is the approximate input power level
for the 1 dB compression.

Channel 2: Swept power gain compression

Select the Sy, trace on channel 2. Place a marker on the trace. Move the marker to
the flat portion of the trace. If there is no flat portion, the amplifier is in compression
throughout the sweep, and the start power level must be decreased.

[Marker] > Marker 1 > Move the marker using the knob
Use the delta marker function to find the power level for which a 1 dB drop in gain

occurs. Use the coupled marker function to place a marker on the B trace and display
the absolute input and output power where compression occurs.

13
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Figure 18. Measure the 1 dB compression accurately using the MW PNA network analyzer.

The B trace marker x-axis value (stimulus) is the input power level and the y-axis
value (response) is the output power level at which the amplifier first compresses.
This measurement can be repeated at multiple frequencies, if desired.




Accuracy Considerations

References

Gain

The major sources of error in a gain measurement with a network analyzer are the frequency
response of the test setup, the source and load mismatch during measurement, and the
system dynamic accuracy. The frequency response of the test setup is the dominant error
in a transmission measurement. A simple response calibration significantly reduces this
error. For greater accuracy, a full 2-port calibration can be used. Mismatch uncertainties
are a function of effective source and load mismatches. A full 2-port calibration not only
reduces the effects of frequency response, it also improves the effective source and

load match.

Dynamic accuracy, a measure of the receiver’s performance as a function of incident
power level, also influences the uncertainty of gain measurements. This is because a
receiver usually sees a different power level between calibration and measurement.

Reverse isolation

Isolation is subject to the same error considerations as gain. In addition, if the isolation
of the amplifier under test is very large, the transmitted signal level may be near the
noise floor and/or crosstalk level. To lower the noise floor, employ averaging or reduce
the IF bandwidth. To reduce crosstalk, perform an isolation calibration.

Reflection

The uncertainty of reflection measurements is affected by directivity, source match, load
match, and the reflection tracking of the test system. With a full 2-port calibration, the
effects of these factors are minimized. A 1-port calibration provides the same accuracy
if the output of the amplifier is well terminated, or if the amplifier’s reverse isolation is
considerably larger than its gain. Since the magnitude of the mismatch uncertainty
depends on the input and output match of an amplifier, a measurement of a better-
matched amplifier will contain less uncertainty.

Gain compression

Swept frequency gain compression measurements employ response calibrations to
reduce uncertainties. Be aware, however, that to determine swept frequency gain com-
pression, the source power level must be changed. Therefore, the validity of the response
calibration is reduced when varying source power for swept frequency measurements.
Swept power gain compression measurements employ source and receiver calibration to
reduce uncertainties. A source power calibration precisely sets the power level incident
upon the amplifier by compensating the source power for any nonlinearities in the source
or test setup.

Microwave PNA Series Network Analyzer Application Note 1408-8,
Amplifier Swept Harmonic Measurements, Literature number 5988-9473EN

Microwave PNA Series Network Analyzer Application Note 1408-9,
Amplifier Intermodulation-Distortion Measurements, Literature number 5988-9474EN
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Web Resources

For additional literature and product infor-
mation about the Agilent PNA Series visit:
www.agilent.com/find/pna

For additional information about Agilent

electronic calibration (ECal) modules visit:
www.agilent.com/find/ecal
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